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 Обсуждение 

Sprint-Layout. Руководство пользователя. 

Предисловие 

Вашему вниманию предлагается учебное пособие к элементарной системе 

автоматизированного проектирования печатных плат Sprint-Layout. Данный учебник 

создан на базе фирменной документации к этой программе. Автором пособия является 

Князев Александр Анатольевич, студент кафедры МТ11 «Электронное машиностроение» 

МГТУ им. Н.Э.Баумана . Эта работа является первой (будем надеяться - не последней) 

серьезной публикацией автора.  



Рекомендуется пользоваться английской версией программы Sprint-Layout. Данное 

пособие ориентировано именно на английскую версию, поскольку русифицированные 

версии имеют значительные неточности в технической терминологии, что может привести 

к неправильному пониманию некоторых функций. Заметно, что такие «русификации», к 

сожалению, делаются зачастую людьми далекими от проектирования или производства 

печатных плат, поскольку они даже не видят различия между шелкографией и паяльной 

маской. При создании пособия автор старался использовать правильную техническую 

терминологию, принятую у производителей печатных плат. Автор выражает надежду, что 

читатели ранее не знакомые с проектированием печатных плат, также научатся называть 

вещи своими именами и не станут впоследствии обзывать контактные площадки 

«пятачками», а паяльную маску странным термином «без паек» (как в одной из 

русифицированных версий).  

Автор выражает благодарность главному технологу учебно-демонстрационного 

комплекса «Электронные технологии» Тахаутдинову Ринату Шаукатовичу за идею 

создания данного пособия и ценые замечания при его написаниии.  

Если после знакомства с данным пособием у Вас остались какие-то вопросы по программе 

Sprint-Layout, или возникли конструктивные предложения по улучшению данного 

пособия, пишите по адресу rottweiler@mail.ru с пометкой Sprint-Layout. Автор с 

удовольствием Вам ответит. Также автору просто интересно узнать Ваше мнение о 

данном пособии.  

Дата последней редакции 17.03.2005.  

1. Введение 

 

Sprint-Layout (далее SL) - это простейшее, но весьма эффективное средство для 

проектирования односторонних и двухсторонних печатных плат. Эта программа содержит 

все необходимые функции (кроме автоматического разводчика) для создания топологии 

плат с максимальными размерами 300х300 мм. SL позволяет сохранять файлы в форматах 

Gerber и Excellon, которые являются стандартом обмена данными при производстве 

печатных плат. Если вы профессионально занимаетесь разводкой печатных плат и 

используете для этого программу типа P-CAD, скорее всего SL вам будет не интересен, 

поскольку развести в нем материнскую плату для компьютера вы точно не сможете (хотя 

китайцы и в Autocad'е восьмислойные платы разводят ). А вот если вы только начинаете 

знакомиться с увлекательным процессом разводки плат, или время от времени 

сталкиваетесь с необходимостью развести несколько НЕ очень больших, НЕ очень 

сложные плат с НЕ очень высокой плотностью элементов, тогда SL - это как раз то, что 

вам нужно.В этом случае нет необходимости тратить свое драгоценное время на освоение 

каких-либо сложных специализированных программ, ведь не смотря на свою 

исключительную простоту, SL позволит вам быстро и достаточно профессионально 

подготовить печатную плату.  
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SL оборудован инструментами для формирования контактных площадок различной 

формы (как для выводного, так и для поверхностного монтажа), проводников, полигонов, 

текста и т.д. Размеры элементов можно изменять в широком диапазоне.  

Для каждой стороны печатной платы предусмотрены два слоя - слой проводников и слой 

маркировки. Слой паяльной маски создается автоматически. Также возможно 

автоматическое создание общей шины, тестирование сетей и т.д.  

Встроенная автоматизированная (но к сожалению не автоматическая) трассировка 

поможет вам развести проводники.  

Библиотека SL содержит ряд наиболее распространенных типоразмеров электронных 

компонентов. При желании эту библиотеку можно легко пополнить.  

2. Создание печатной платы 

2.1. Размеры платы 

При создании новой платы прежде всего необходимо задать ее размеры. Откройте в меню 

Board > Board properties или щелкните левой кнопкой мыши под словами Board properties 

в нижней части редактора. Также можно нажать правой кнопкой мыши по закладке Board 

слева в нижней части редактора и в выпадающем меню выбрать Properties.  

 

В открывшемся окне можно задать Ширину - Width и Высоту - Height платы, а также ее 

Название - Name, которое будет отображаться на закладке. Размеры платы не могут быть 

больше, чем 300х300 мм.  

Вы можете вернуться к диалогу в любой момент, если захотите изменить размеры или 

название платы.  

2.2. Размер сетки 

Сетка позволяет более точно размещать элементы топологии. Привязка к сетке включена 

всегда. Даже если выбранный масштаб изображения слишком мал, чтобы отображать 

привязку визуально, она все равно остается включенной.  

Чтобы отключить привязку нажмите и держите кнопку Ctrl на клавиатуре, когда 

перемещаете какой-либо объект в поле редактора.  
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Вы можете изменить размер сетки, если необходимо. Это никак не повлияет на 

топологию. Если вы не можете добраться до нужного места на плате, попробуйте 

уменьшить размер сетки. По умолчанию рекомендуется использовать сетку размером 1/10 

дюйма (2,54 мм) или кратные ей размеры. Чтобы установить размер сетки нажмите 

кнопку на панели инструментов слева внизу:  

 

Появится выпадающее меню:  

 

Это меню предлагает семь стандартных размеров сетки, подходящих для большинства 

задач. Вы также можете добавить новый размер сетки в выпадающее меню. Для этого 

нажмите Add new grid value… в выпадающем меню. Можно задать размер сетки от 0,01 

мм до 99,9 мм. Выберите нужное значение и нажмите OK. Новый размер сетки появится в 

выпадающем меню.  

Чтобы удалить какой-либо размер сетки из выпадающего меню, поставьте напротив него 

галочку и нажмите в меню Remove current grid value.  

Маркер сетки 

Обычно для удобства оценки расстояний в поле редактора каждая пятая линия сетки 

утолщена по сравнению с другими. В разделе выпадающего меню Subdivisions вы можете 

выбрать, через сколько клеток линия сетки утолщается, или вообще отключить утолщение 

линий.  

Отображение и сокрытие сетки 

Чтобы показать или скрыть сетку, в выпадающем меню соответственно выставите или 

снимите галочку перед пунктом Show grid. Имейте ввиду, что привязка к сетке остается 

включенной даже когда сетка скрыта.  

2.3. Слой проводников и слой маркировки 

В SL для каждой платы предусмотрено четыре слоя. Слои можно представить как 

прозрачные пленки, лежащие одна поверх другой. Для каждой стороны платы существует 
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два слоя, один – слой проводников, в котором располагается непосредственно топология 

(контактные площадки и соединяющие их дорожки), и другой – слой маркировки 

(непроводящий), который используется для графического указания расположения 

электронных компонентов и различных служебных отметок.  

Четыре слоя в SL – это:  

 C1 (Copper 1) 1-я сторона платы – слой проводников 

 S1 (Silk screen 1) 1-я сторона платы – слой маркировки 

 C2 (Copper 2) 2-я сторона платы – слой проводников 

 S2 (Silk screen 2) 2-я сторона платы – слой маркировки 

Вы можете задать цвет каждого слоя.  

Пожалуйста обратите внимание при создании своей платы:  

 1-я сторона платы – это верхняя сторона платы. 

 2-я сторона платы – это нижняя сторона платы. 

 Создавайте свою топологию так, как если бы ваша плата была прозрачной. 

 Учтите, что элементы и текст на нижней стороне вашей платы (сторона 2) должны 

быть отраженными (обычно SL делает это для вас автоматически). 

Только один из слоев может быть активным (доступным для редактирования) в даный 

момент времени. Это значит, что каждый новый элемент будут помещен на активный 

слой, а остальные слои в этот момент изменять нельзя.  

Чтобы переключить активный слои, выберите соответствующий слой из пункта Layer > 

Active главного меню. Также можно использовать панель в нижней части редактора:  

 

Разноцветные кнопки C1 S1 C2 S2 (хотя если вы поменяли цветовые установки SL эти 

кнопки могут быть и другого цвета) делают соответствующие слои 

видимыми/невидимыми, а ниже с помощью переключателя можно выбрать активный 

слой.  

Активный слой всегда видимый. Вы также можете использовать кнопки F1…F4 на 

клавиатуре для выбора активного слоя. Кнопки F5…F8 позволяют переключать 

видимые/невидимые слои.  

Нажав на кнопку ? вы увидите следующее информационное окно:  
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Здесь наглядно объясняется расположение слоев и их графическая интерпретация.  

2.4. Линейки и панель навигации 

Для измерения расстояний в верхней и левой частях редактора расположены 

координатные линейки. В качестве единицы шкалы можно выбрать миллиметр (М) или 

дюйм (I), нажав кнопку между линейками. (Также можно сделать это в разделе главном 

меню: Options.) Текущая позиция курсора отмечается на линейках красными полосками 

для более удобного ориентирования.  

Панель навигации 

 

Текущие координаты курсора отображаются в левом нижнем углу редактора. Единица 

измерения соответствует выбранной для линеек.  

Начало координат 

Обычно начало координат расположено в верхнем левом углу редактора и обозначается 

синей точкой. Вы можете перетащить эту синюю точку левой кнопкой мыши в любое 

удобное вам место. Координаты немедленно начнут отсчитываться от нового начала.  

Если на текущем виде начало координат не отображается, вы можете установить его так: 

щелкните правой кнопкой мыши в нужном месте и в выпадающем меню выберите Set 

origin.  
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При перетаскивании начало координат можно установить только в углах сетки. Нажмите 

и удерживайте кнопку Ctrl на клавиатуре, чтобы временно отключить привязку к сетке и 

установить начало координат в произвольном месте.  

3. Функции формирования топологии 

3.1. Основные функции формирования топологии 

SL предлагает все необходимые функции для создания топологии печатных плат.  

На панели инструментов слева расположены кнопки, которые включают 

соответствующий режим добавления различных элементов топологии. Режим по 

умолчанию (указка) – это режим редактирования. Он используется для выбора, 

перемещения и трансформации объектов топологии.  

Если в поле редактора нажать правую кнопку мыши, появится выпадающее меню, которое 

предлагает некоторые часто используемые функции.  

Выделение объектов 

Выделение объектов топологии для их перемещения или трансформации производится в 

режиме редактирования (указка). Просто щелкните по объекту, чтобы выделить его. 

Выделенный объект поменяет свой цвет на розовый. Если вы хотите выделить несколько 

объектов, выберите их с помощью рамки (передвигайте мышь, удерживая левую кнопку). 

Все объекты, оказавшиеся внутри рамки, будут выделены.  

Вы можете добавлять отдельные объекты к уже выделенным или удалить из выделенных, 

удерживая кнопку Shift на клавиатуре и щелкая по отдельным объектам.  

Перемещение элементов 

Выделите элементы, которые необходимо передвинуть. Затем щелкните по одному из 

выделенных элементов, удерживая левую кнопку мыши передвиньте элементы в нужную 

позицию и отпустите кнопку мыши.  

Удерживайте кнопку Ctrl на клавиатуре, если хотите отключить привязку к сетке.  

Для перемещения выделенных элементов вы также можете использовать кнопки со 

стрелками (вверх, вниз, вправо, влево) на клавиатуре.  

Удаление объектов 

Выделите элементы, которые нужно удалить. Затем выполните одно из следующих 

действий:  

 нажмите в главном меню Edit > Delete 

 нажмите кнопку с изображением корзины на верхней панели инструментов 

 щелкните в поле редактора правой кнопкой мыши и в выпадающего меню 

выберите Delete 

 просто нажмите кнопку Delete на клавиатуре 



3.2. Проводники 

Чтобы добавить новый проводник к топологии, выберите соответствующий режим на 

левой панели инструментов:  

 

Передвигайте курсор в поле редактора. Курсор теперь сопровождается кружочком, 

диаметр которого соответствует ширине проводника. Щелкнув левой кнопкой мыши в 

нужном месте, задайте начальную точку проводника. Теперь передвигайте курсор к 

конечной точке проводника. Нажимите несколько раз кнопку Пробел на клавиатуре, 

чтобы найти оптимальную траекторию проводника. Щелкните еще раз левую кнопку 

мыши, чтобы закрепить проводник, и таким же образом прокладывайте следующий 

сегмент проводника. Чтобы завершить процесс, нажмите правую кнопку мыши.  

Установить ширину проводника можно с помощью инструмента на левой панели:  

 

Введите нужное значение непосредственно в числовую ячейку или зажав левую кнопку 

мыши правее ячейки перемещайте курсор вверх-вниз.  

Ширина проводника зависит от возможностей выводящего устройства (плоттера). 

Нулевое значение соответствует наименьшей ширине проводника, которую может 

воспроизвести выводящее оборудование.  

Если вы постоянно используете несколько определенных значений ширины проводника, 

для более удобного переключения между этими значениями можно записать их в 

выпадающее меню, которое открывается, если нажать слева от числовой ячейки. 

Выберите Add, чтобы добавить текущую ширину проводника в выпадающее меню. Вы 

можете быстро вызвать записанное значение из выпадающего меню. Чтобы удалить 

значение из выпадающего меню выберите его и нажмите Remove в выпадающем меню.  

Изменение существующих проводников 

Чтобы изменить существующий проводник, выделите его. Узлы проводника отметятся 

синими точками. Вы можете передвигать узлы проводника в новое положение, захватив 

синюю точку левой кнопкой мыши. Если вы щелкните правой кнопкой мыши на одном из 

синих узлов, появится выпадающее меню, которое предложит Удалить узел - Remove, 

Добавить узел - Add corner, и Разрезать проводники - Split tracks (разделить один на 

несколько).  

Чтобы изменить ширину проводника, выделите его (можно выбрать несколько 

проводников). На левой панели инструментов числовое поле с шириной проводника 

подсветится красным цветом. (Если вы выбрали несколько проводников разной ширины, 

высветится ширина только одного какого-либо проводника.) Вы можете задать в 

числовом поле новое значение ширины проводника (для всех выбранных проводников).  

3.3. Контактные площадки для выводного монтажа, переходные отверстия 
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Чтобы расставить контактные площадки, выберите соответствующий режим, нажав 

кнопку на левой панели инструментов:  

 

SL предлагает несколько различных форм контактных площадок. Текущая форма 

отображается на кнопке. Чтобы выбрать другую форму площадки, нажмите кнопку со 

стрелкой справа от кнопки площадки.  

Если выбрана опция Переходная площадка - Through pad, площадка при установке с 

одной стороны платы автоматически появится также и на обратной стороне (они нужны 

для соединения проводников с разных сторон платы). Такая площадка отображается 

заштрихованной.  

В режиме контактной площадки передвигайте курсор по плате. Каждый щелчок добавляет 

новую контактную площадку на плату. Чтобы завершить процесс, нажмите правую 

кнопку мыши.  

Контактная площадка всегда содержит отверстие в центре. Таким образом можно 

добавлять монтажные отверстия на полигоны (массивные проводящие площадки) или на 

широкие проводники (шире наружного диаметра площадки).  

Наружный диаметр и диаметр отверстия контактной площадки настраиваются на левой 

панели инструментов:  

 

Если вы часто используете контактные площадки нескольких определенных размеров, 

можно записать их значения в выпадающее меню для более быстрого переключения 

между ними (все аналогично как в разделе Проводники).  

Изменение существующих контактных площадок 

Выделите площадку (а можно несколько). Диаметры и форма выбранной площадки 

(только одного какого-нибудь, если выбрано несколько) отображаются на левой панели 

инструментов. Вы можете изменить эти параметры, если необходимо.  

Поменять выделенную контактную площадку на переходную можно кнопкой F12 на 

клавиатуре.  

Обычные отверстия 

Обычные отверстия – неметаллизированные, без контактных площадок - могут 

понадобиться, например, для установки на плате каких-либо корпусов, экранов или для 

закрепления самой платы в корпусе. Установите внутренний и наружный диаметры 

контактной площадки одинаковыми, чтобы получить обычное отверстие. Такие отверстия 

отображаются белыми с перекрестием.  

3.4. Контактные площадки для поверхностного монтажа 

/_detail/faq/sprint_layout/11.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/12.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/11.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/12.gif?id=faq%3Asprint_layout


Чтобы разместить SMD-площадки (площадки для поверхностного монтажа), включите 

соответствующий режим, нажав кнопку на левой панели инструментов:  

 

В режиме SMD-площадок передвигайте курсор по плате. Каждый щелчок добавляет 

новую SMD-площадку на плату. Чтобы завершить процесс, нажмите правую кнопку 

мыши.  

Размеры SMD-площадки настраиваются на левой панели инструментов:  

 

Вы можете записать несколько размеров SMD-площадок в выпадающее меню (все 

аналогично как в разделе Проводники).  

Изменение существующих SMD-площадок 

Выделите SMD-площадку (а можно несколько). Размеры выбранной SMD-площадки 

(только одной какой-нибудь, если выбрано несколько) отображаются на левой панели 

инструментов. Вы можете изменить их, если нужно. Изменения вступают в силу 

немедленно.  

3.5. Проводники в форме окружности/сегмента 

Для добавления на плату проводника в форме окружности включите соответствующий 

режим, нажав кнопку на левой панели инструментов:  

 

Передвигайте курсор по плате. Курсор сопровождается кружочком, диаметр которого 

соответствует ширине проводника (и толщине окружности). Зажмите левую кнопку мыши 

в точке, где хотите расположить центр окружности, и не отпуская кнопку перемещайте 

курсор, таким образом выбирая диаметр. Отпустите кнопку мыши и окружность будет 

создана. Чтобы выйти из режима, нажмите правую кнопку мыши.  

Изменение существующих окружностей 

Выделите окружность. Ее толщину можно изменить в числовом поле редактирования 

ширины проводника на левой панели инструментов.  

Сегменты окружностей 

Любую окружность можно преобразовать в сегмент. Для этого на каждой выделенной 

окружности есть две точки синего цвета (в начальный момент они совпадают), потянув за 

которые можно задать начальную и конечную точки сегмента. Обе точки изначально 

находятся в положении “3 часа” (т.е. 0 градусов).  

Для более точной настройки сегмента можно вызвать диалог: выделите окружность, 

щелкните по ней правой кнопкой мыши и в выпадающем меню выберите Segment.  
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В открывшемся диалоге вы можете установить точно Начальный угол сегмента - Start 

angle, Конечный угол - Stop angle и, если необходимо, отметить Заливку сегмента - Fill 

segment (вся его внутренняя область станет проводящей). Отсчет углов производится 

против часовой стрелки, как показано на рисунке.  

Обратите внимание , что вы не сможете экспортировать сегмент с заливкой в формат 

Gerber!  

3.6. Заливка 

Заливка – это массивная проводящая площадка (шина), на которую могут замыкаться 

несколько проводников. Контур заливки вычерчивается также, как проводники.  

Чтобы создать новую заливку, включите соответствующий режим, нажав кнопку на левой 

панели инструментов:  

 

Перемещайте курсор по плате. Курсор сопровождается кружочком, диаметр которого 

соответствует ширине проводника. Первый щелчок задает начальную точку контура 

заливки. Теперь передвиньте курсор к следующей точке контура. Нажмите несколько раз 

кнопку Пробел на клавиатуре, чтобы найти оптимальную траекторию для отрезка. 

Щелкните еще раз левую кнопку мыши, чтобы закрепить отрезок, и продолжайте таким 

же образом со следующим отрезком. Чтобы завершить процесс, нажмите правую кнопку 

мыши. SL закроет контур и зальет его автоматически. Для заливки необходимы, по 

крайней мере, три точки, иначе она не будет создана. Контур заливки можно закрыть и 

вручную.  

Толщину контура заливки можно изменять на левой панели инструментов:  

 

Изменение существующей заливки 

Выделите заливку. Узлы контура отметятся синими точками. Вы можете перетащить их в 

новое положение. Если вы щелкните правой кнопкой мыши по одному из узлов, появится 

выпадающее меню, которое предложит Удалить узел - Remove из контура или Добавить 
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узел - Add corner в контур. Также можно поменять толщину контура заливки на левой 

панели инструментов.  

3.7. Многоугольники 

Этот режим позволяет создавать проводящие равносторонние многоугольники. Такие 

многоугольники можно использовать во вспомогательных целях. Например, если вам 

нужно расставить 12 контактных площадок по окружности на равном расстоянии, 

начертите 12-тиугольник, расставьте по углам контактные площадки, а многоугольник 

удалите.  

Чтобы создать многоугольник, включите соответствующий режим, нажав кнопку на левой 

панели инструментов:  

 

Появится следующий диалог:  

 

Задайте в нем следующие параметры:  

 Количество углов многоугольника (1…99) - Number of corners. 

 Радиус описанной окружности (измеряется от центра до угла) - Radius. 

 Толщину линий контура - Line width. 

 Угол поворота ( -180…+180 градусов) - Angle offset. 

 если отмечен пункт Залить - Fill, вся внутренняя область многоугольника будет 

проводящей. 

Подтвердите выбранные параметры, нажав OK. Теперь вы можете разместить 

многоугольник на плате несколько раз подряд. Чтобы завершить процесс, нажмите 

правую кнопку мыши.  

Изменение существующих многоугольников 

Многоугольники можно изменять точно так же, как проводники или заливку.  

3.8. Текст 
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Текстовые надписи следует создавать в слоях маркировки S1, S2 (Конечно, если вы 

хотите, чтобы маркировка была непроводящей). Чтобы создать текстовую надпись, 

включите соответствующий режим, нажав кнопку на левой панели инструментов:  

 

Появится следующий диалог:  

 

Введите в поле Text свою надпись (только латинскими буквами!) и задайте 

дополнительные параметры:  

 Высота букв - Height 

 Толщина букв - Width (Thin - тонкие; Normal - обычные; Bold - жирные) 

 Ширина надписи - Style (Narrow - узкая; Normal - обычная; Wide - широкая) 

 Поворот - Orientation (0 градусов - без поворота) 

 Отразить - Mirror (относительно оси Horizontal - горизонтальной; Vertical - 

вертикальной) 

 Автоматическая нумерация для создания пометок с последовательными номерами 

(например, R1,R2,…) - Add number (Start at - начать с номера) 

Подтвердите выбранные параметры, нажав кнопку OK. Теперь вы можете разместить 

текст на плате в нужной позиции.  

Изменение существующего текста 

Чтобы изменить текстовую надпись, просто дважды щелкните по ней левой кнопкой 

мыши. Появится предыдущий диалог, в котором вы сможете внести необходимые 

изменения.  

4. Функции редактирования 

4.1. Использование буфера обмена 

Обычные функции раздела Edit (редактирование) главного меню используют буферу 

обмена и позволяют выполнять стандартные действия с выделенными объектами:  
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 вырезать 

 копировать 

 вставить 

 дублировать 

Эти функции также доступны на верхней панели инструментов.  

Вырезать: Копирует выделенные объекты в буфер и удаляет их с платы.  

Копировать: Копирует все выделенные объекты в буфер. Исходные объекты остаются 

на плате.  

Вставить: Добавляет содержимое буфера на плату. Вставляемые объекты 

перемещаются вместе с курсором. Вы можете закрепить их щелчком мыши.  

Дубликат: Выполняет копирование и вставку за одну операцию.  

Когда вы копируете объекты в буфер, SL также копирует их в общий буфер Windows. Это 

значит, что в других приложениях можно вставлять эти объекты из буфера. Буфер 

Windows использует формат EMF (расширенный метафайл). Программа, которая 

импортирует объекты, должна поддерживать этот формат.  

4.2. Лупа 

Чтобы настроить лупу, нажмите соответствующую кнопку на левой панели инструментов:  

 

Курсор примет форму лупы. Теперь левая кнопка мыши увеличивает объекты, а правая 

уменьшает (можно также пользоваться колесиком мыши, причем в этом случае включать 

режим лупы не обязательно). Вы также можете выделить рамку, чтобы увидеть ее 

содержимое во весь экран.  

Специальные функции лупы, которые можно использовать, нажав значок лупы на верхней 

панели инструментов:  

вернуться к предыдущему виду  

плата целиком  

все объекты платы  

выделенная часть платы  

На левой панели инструментов есть «карта навигации» - маленькое зеленое поле, которое 

показывает, какая область платы отображается в данный момент в окне редактора. 

Включить или выключить его можно в разделе Options главного меню.  
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Темно-зеленый прямоугольник символизирует всю плату, а светло-зеленый – ту часть 

платы, которая показывается в данный момент в редакторе. Вы можете захватить светло-

зеленый прямоугольник и двигать его по темно-зеленому, чтобы увидеть определенную 

область платы.  

 Щелкните по светло-зеленому прямоугольнику левой кнопкой мыши, чтобы 

увеличить размер элементов. 

 Щелкните правой кнопкой, чтобы уменьшить. 

Для использования «карты навигации» не нужно включать режим лупы.  

4.3. Поворот, отражение и выравнивание 

Эти функции доступны на верхней панели инструментов и из выпадающего меню в поле 

редактора (правая кнопка мыши).  

Поворот: Эта функция поворачивает выделенные элементы на 90 градусов по часовой 

стрелке.  

Зеркало по вертикали/горизонтали: Отражает выделенные элементы относительно 

вертикальной/горизонтальной оси.  

Выравнивание: Выравнивает все выделенные элементы сверху, снизу, слева, справа, 

горизонтально по центру, вертикально по центру.  

Выравнивание по сетке: Размещает все выделенные объекты вдоль сетки. Внимание! 

Это может изменить расстояния между объектами, которые не сгруппированы. 

Относительные положения объектов, которые объединены в группы, не изменятся. В этом 

случае перемещается вся группа.  

4.4. Работа с группами объектов 

Отдельные элементы платы можно объединить в группы (блоки). Эта функция позволяет 

выбирать, перемещать и редактировать все элементы группы за одну операцию. 

Отдельные элементы группы также защищены от нежелательных изменений. Отдельный 

элемент, который является частью группы, нельзя удалить. Для создания группы нужны, 

как минимум, два элемента. Группа может содержать любые элементы платы, а также 

другие группы.  

Если вы хотите удалить или изменить отдельный элемент группы, вы должны сначала 

разбить группу. Когда вы разбиваете группу, подгруппы, которые в нее входят, остаются 

без изменения. Если вы хотите разбить такую подгруппу, повторите операцию для нее.  
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Чтобы сгруппировать/разгруппировать элементы, выделите их и выполните одно из 

следующих действий:  

 нажмите соответствующую кнопку на верхней панели инструментов 

 выберите в главном меню Functions > Build group (объединить в группу) / Split 

proup (разбить группу) 

 нажмите в поле редактора правую кнопку мыши и в выпадающем меню выберите 

соответственно те же пункты 

SL группирует элементы автоматически, когда они вставляются из буфера или из 

библиотеки компонентов. Это облегчает размещение элементов. Вы можете разбить эти 

группы, как и любые другие.  

4.5. Перемычки 

Перемычками - это тонкие прямые линии, которыми можно соединять контактные 

площадки, между которыми необходимо развести проводники.Перемычки используются 

во вспомогательных целях и не являются частью топологии.  

Перемычки также нужны для работы со встроенной автотрассировкой. Автотрассировка 

использует перемычки для автоматизированной разводки проводников.  

Перемычки также помогают найти подходящее место для компонентов. Вы можете 

использовать их, чтобы избежать пересечения проводников при размещении компонентов 

на плате.  

Чтобы расставить перемычки на своей плате, включите соответствующий режим, нажав 

кнопку на левой панели инструментов:  

 

Перемычки можно формировать только между контактными площадками. Щелкните по 

одной из площадок. Теперь тяните “резинку” к другой площадке и щелкните по ней, 

чтобы установить перемычку. При расстановке перемычек площадки подсвечиваются, 

когда курсор проходит над ними.  

Чтобы завершить процесс, нажмите правую кнопку мыши.  

Удаление существующих перемычек 

Чтобы удалить перемычку, протяните ее еще раз (поверх существующей), и она удалится.  

Автоматическое удаление перемычек 

Выберите в главном меню Functions > Remove connections (rubberbands) или нажмите 

соответствующую кнопку на верхней панели инструментов. SL проверит все 

перемычки и удалит перемычку, если между площадками, которые она соединяет, уже 

проложена дорожка. SL учитывает также переходные площадки для двухсторонних плат. 
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Информационное окно сообщит вам о количестве удаленных и оставшихся перемычек, 

когда проверка закончится.  

4.6. Автотрассировка 

SL содержит простую автоматизированную трассировку от точки к точке. 

Автотрассировка поможет проложить проводник между двумя точками, предварительно 

соединенными перемычками. Автотрассировка не может автоматически развести всю 

плату целиком. Чтобы правильно развести плату, вам придется искать пути 

самостоятельно.  

Для использования автотрассировки нажмите соответствующую кнопку на левой панели 

инструментов:  

 

Появится окно настройки:  

 

Width - Ширина проводника, который проложит автотрассировка.  

Distance - минимальный Зазор между проводником и другими элементами.  

Автотрассировка перемычек 

Наведите курсор на перемычку. Когда курсор находится над перемычкой, она 

подсвечивается. Теперь простым щелчком вы можете автоматически проложить 

проводник.  

Автоматически проложенная проводник размещается в слое, который активен в данный 

момент. Убедитесь, что включен нужный слой.  

Автотрассировка ищет кратчайший путь для размещения проводника, а также проверяет 

минимальный заданный зазор между прокладываемым проводником и встречающимися 

на пути:  

 элементами активного слоя 

 сквозными отверстиями 

Если автотрассировка найдет путь, будет создан проводник. Иначе вы получите 

сообщение об ошибке.  

Автоматически проложенный проводник отображается с внутренней полосой. Таким 

образом вы можете отличить автоматически проложенный проводник от обычного.  

Отмена автотрассировки 
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Вы можете поменять автоматически проложенную дорожку обратно на перемычку. Для 

этого просто щелкните по дорожке.  

Редактирование автопроводника Вы можете редактировать автоматически проложенный 

проводник также, как обычный - настраивать ширину, передвигать узлы и т.д.  

Советы Если вам нужно развести много перемычек, начните разводить сначала самые 

короткие и простые. Если вы видите, что один автопроводник блокирует удобные пути 

для других соединений, просто отмените этот автопроводник и попробуйте сначала 

другую перемычку. Попробуйте формировать проводники в разной последовательности, 

чтобы достичь лучшего результата.  

С гораздо большей вероятностью автотрассировка найдет путь, если вы зададите 

меньшую ширину дорожки и меньший зазор. Попробуйте уменьшить эти значения, если 

автотрассировка не может найти путь для проводника. В любом случае вы сможете 

отредактировать проложенный проводник, если необходимо.  

4.7. Тестирование сетей 

Эта функция находит соединенные между собой проводники, контактные площадки и 

другие проводящие области на плате. Это облегчает проверку сигнала, текущего по плате. 

Соединенныемежду собой области подсвечиваются.  

Включите режим тестирования, нажав соответствующую кнопку на левой панели 

инструментов:  

 

Курсор примет форму щупа. Просто щелкните по любой проводящей точке вашей 

топологии, и функция найдет все проводники, контактные площадки и другие области, 

которые соединены с этой точкой. Соединения через переходные отверстия и проводники 

с обратной стороны платы также учитываются в процессе тестирования. Теперь вы 

можете продолжить тестирование, щелкнув по следующей точке или выйти из режима 

тестирования, нажав правую кнопку мыши.  

4.8. Измерение расстояний 

Эта функция позволяет измерять расстояния и углы на вашей плате. Чтобы включить 

режим измерения, нажмите соответствующую кнопку на левой панели инструментов:  

 

Теперь вы можете щелкнуть по любой точке вашей платы и выделить рамку (не отпуская 

левую кнопку мыши):  
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Вы увидите следующие значения:  

 dX - расстояние по X (горизонтальное) 

 dY - расстояние по Y (вертикальное) 

 Distance - абсолютное расстояние между точками (по прямой) 

 Angle - угол, между прямой, соединяющей точки, и горизонталью 

С помощью этих значений вы можете точно измерять свою плату. Измерение будет более 

точным, если объекты увеличены (воспользуйтесь лупой).  

Выключить режим измерения можно правой кнопкой мыши.  

4.9. Общая шина 

Эта функция автоматически заполняет пустые области платы проводящей заливкой. При 

производстве платы это ускоряет процесс травления и экономит химический травитель. 

Вы также можете использовать эту функцию при создании экрана для высокочастотной 

платы. Обратите внимание , что функция создает область НЕ связанную ни с какими 

проводниками на плате.  

Функция общей шины доступна для обеих сторон платы. Чтобы включить/выключить 

общую шину, нажмите соответствующую кнопку в нижней части редактора:  

 

Теперь общая шины включена и отображается на вашей плате. Вы можете 

включать/выключать общую шину когда хотите без какой-либо потери данных.  

В числовом поле справа от кнопки настраивается размер зазора между общей шиной и 

остальными элементами платы. Этот зазор можно настроить для любого конкретного 

элемента платы (числовое поле отображается, только если общая шина включена). 

Поэтому сначала выберите какие-нибудь элементы.  

Нулевой зазор замыкает элементы на общую шину!  

Окна в общей шине 

Вы можете создать в общей шине окна, которые останутся незалитыми. Чтобы создать 

такую область, нажмите на заштрихованную кнопку под числовым полем настройки 

/_detail/faq/sprint_layout/46.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/47.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/46.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/47.gif?id=faq%3Asprint_layout


зазора. Вычерчиваются и редактируются незалитые области точно так же, как обычная 

заливка.  

Внимание! В зависимости от заданного минимального зазора между проводниками и 

контактными площадками, включение общей шины может привести к нежелательному 

появлению слишком узких участков между проводящими областями.  

 

На рисунке показаны закороченные участки между проводниками.  

Пожалуйста, внимательно проверьте свою плату, перед использованием функции общей 

шины. Чтобы предотвратить образование закороченных участков, можно передвинуть 

проводники в другое положение, изменить зазор между общей шиной и остальными 

элементами или использовать окна в общей шине. Вообще, если общая шина для данной 

платы не имеет принципиального электротехнического смысла, использовать ее 

совершенно не обязательно.  

4.10. Фотовид 

Функция фотовида позволит вам увидеть вашу плату так, как она будет выглядеть после 

производства, с отверстиями, маркировкой и т.д. Это поможет вам найти типичные 

ошибки, такие как неправильно отраженные компоненты и текст.  

Чтобы включить фотовид, нажмите соответствующую кнопку на левой панели 

инструментов:  

 

Появится окно настройки фотовида:  

 

Side 1 - Показать верхнюю сторону платы.  

Side 2 - Показать нижнюю сторону платы (отраженную).  

With silkscreen - Показать маркировку.  

X-Ray - Сделать плату прозрачной, так чтобы было видно, что расположено на обратной 

стороне.  

В режиме фотовида вы можете увеличивать/уменьшать изображение с помощью мыши.  
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4.11. Управление с клавиатуры 

С помощью клавиатура можно более удобно работать с некоторыми функциями, а также 

использовать некоторые дополнительные.  

Ctrl - Нажмите и удерживайте эту кнопку, чтобы временно отключить привязку к сетке.  

Стрелки - Позволяют передвигать выделенные объекты топологии на шаг сетки. В 

сочетании с кнопкой Ctrl шаг 1/100 мм.  

F1…F4 - Выбрать активный слой.  

F5…F8 - Делать слои видимыми/невидимыми.  

Пробел - Выбрать один из пяти различных режимов изгиба для проводников.  

Delete - Удалить выделенные элементы.  

Ctrl + Z - Отменить последнюю операцию.  

Ctrl + Y - Повторить последнюю отмененную операцию.  

Ctrl + C - Скопировать выделенные объекты в буфер.  

Ctrl + X - Вырезать выделенные объекты в буфер.  

Ctrl + V - Вставить объекты из буфера.  

Ctrl + D - Дублировать выделенные объекты.  

Ctrl + A - Выделить все.  

Ctrl + R - Повернуть выделенные элементы.  

Ctrl + H - Отразить выделенные элементы горизонтально.  

Ctrl + T - Отразить выделенные элементы вертикально.  

Ctrl + G - Объединить выделенные элементы в группу.  

Ctrl + U - Разбить выделенную группу.  

Ctrl + W - Переместить выделенные элементы на обратную сторону платы.  

4.12. Редактирование нескольких плат 

Когда вы работаете над проектом, который состоит из нескольких плат, вы можете 

сохранить все платы в один единственный файл на диске. Закладки в нижней части 

редактора позволяют переключаться между платами проекта:  



 

Щелчок по закладке левой кнопкой мыши показывает в редакторе соответствующую 

плату. Щелчок правой кнопкой открывает выпадающее меню, которое предлагает 

дополнительные опции для закладок. Эти опции также доступны в разделе Board главного 

меню.  

Add new board - Добавить новую, пустую плату в проект. Введите в диалоге размеры 

платы и ее название.  

Board properties - Вызвать диалог свойств текущей платы, который позволяет изменить 

название и размеры платы.  

Delete board - Удалить текущую плату из проекта. Проект должен содержать по крайней 

мере одну плату.  

Set board to left / right - Переместить закладку текущей платы соответственно в 

начало/конец списка закладок.  

Move board to left / right - Переместить закладку текущей платы соответственно на один 

шаг влево/вправо в списке закладок.  

Import board from file… - Импортировать все платы из другого файла проекта SL (*.LAY).  

4.13. Автосохранение 

Функция автоматического сохранения регулярно сохраняет вашу работу. Вы можете 

включить эту опцию и задать интервал сохранения. Выберите в главном меню File > 

Autosave.  

 

Поставьте в окне галочку, чтобы включить автосохранение и задайте интервал 

сохранения.  

Если функция автосохранения включена, создается резервный файл (*.bak) вашего 

проекта и все изменения регулярно сохраняются в этот файл с заданным интервалом. 

Файл проекта (*.LAY) остается неизменным, так что не забудьте сохранить свою работу 

перед выходом из SL, даже если функция автосохранения включена.  
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Если вы утратите свой проект (*.LAY) по каким-либо причинам (например вследствие 

зависания компьютера), вы можете поменять расширение резервного файла *.bak на 

*.LAY, и ваша работа будет восстановлена.  

4.14. Фоновое изображение 

Отсканированные платы или чертежи можно использовать как образец для 

воспроизведения топологии. Если такой рисунок доступен в формате BMP, его можно 

расположить на заднем плане редактора.  

Убедитесь, что файл BMP монохромный (черно-белый). Если сканированный файл имеет 

другой формат, используйте графические редакторы для создания подходящего файла.  

Для файла BMP рекомендуется разрешение 600 dpi. Более низкое разрешение снижает 

качество. Более высокое перегружает оперативную память без повышения качества.  

Загрузка рисунка 

В главном меню выберите Options > Scanned copy… или нажмите на соответствующую 

кнопку на верхней панели инструментов:  

Диалог для фонового рисунка предлагает следующие опции:  

 

Board side 1/2 - Рисунок можно загрузить для верхней (1) и нижней (2) сторон платы.  

Load bitmap… - Загрузить файл рисунка на задний фон редактора.  

Delete bitmap - Удалить рисунок из редактора.  

Show bitmap - Показать рисунок в редакторе. Выключение этой опции скрывает рисунок.  
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Resolution - Настроить разрешение загружаемого рисунка. Убедитесь, что рисунок имеет 

правильный масштаб, когда отображается в редакторе. Иначе исправьте разрешение в 

этом поле.  

X/Y-Offset - Сдвиг по X/Y. Используйте эти поля, чтобы настроить положение рисунка в 

редакторе. Изменение этих значений немедленно отображается в редакторе.  

Colour - Выбрать цвет рисунка.  

Вы можете вернуться к диалогу в любое время, когда захотите внести изменения.  

5. Макросы 

5.1. О макросах 

Библиотека компонентов SL состоит из так называемых макросов. Макросы - это чертежи 

типовых элементов (в основном компонентов, таких как резисторы, транзисторы и т.д.). 

Вы можете использовать эти элементы для своей топологии, а также создавать 

собственные макросы.  

5.2. Использование макросов 

Чтобы использовать макросы в своей топологии нужно открыть библиотеку макросов. 

Выберите в меню Options > Macro library или нажмите соответствующую кнопку на 

верхней панели инструментов .  

Окно библиотеки макросов появится справа.В верхней части окна можно открывать 

соответствующие разделы библиотеки.  

 

При нажатии на левую кнопку (здесь DIL) появляется список доступных папок с 

макросами. Выберите нужную папку. Существует корневая папка макросов, которая 

содержит все остальные подпапки. Эта корневая директория задается при установке 

приложения (Папка программы\Macros).Чтобы сменить путь к корневой папке макросов, 

нажмите правую кнопку с изображением папки.  

Выбор макроса 

Под кнопкой управления папками вы увидете список всех макросов в выбранной папке. 

Щелкните по одному из элементов списка, чтобы включить предварительный просмотр 

выбранного макроса. К каждому макросу добавляются 2 строки текста для описания. 

Перетащите мышью макрос из окона предпросмотра в окно редактора, чтобы добавить 

макрос на свою плату. Макрос будет помещен на активный слой платы.  

Функции для работы с макросами 

Сохранить: Сохраняет все выделенные элементы вашей топологии в качестве нового 

макроса.  

/_detail/faq/sprint_layout/54.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/55.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/56.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/54.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/55.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/56.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/54.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/55.gif?id=faq%3Asprint_layout
/_detail/faq/sprint_layout/56.gif?id=faq%3Asprint_layout


Удалить: Удаляет выбранные макросы с вашего диска.  

Переходные площадки: Преобразует все контактные площадки макроса в 

двухсторонние.  

Отразить макрос: Если кнопка нажата, при добавлении макроса к топологии, он 

автоматически вставится отраженным.  

Поменять сторону: Если кнопка нажата, макрос встанет на обратную сторону платы.  

Внимание! Последние 2 функции можно использовать совместно, т.к. при смене стороны 

платы обычно требуется отразить элемент.  

Чтобы закрыть окно макросов нажмите кнопку Х в верхней его части. Чтобы поменять 

ширину окна макросов, поместите курсор между окнами библиотеки и редактора, он 

примет форму двойной стрелки. Удерживая левую кнопку мыши передвигайте курсор 

вправо-влево.  

5.3. Создание пользовательских макросов 

Разницы между рисованием макроса и любой другой топологии нет. Используйте слои 

проводников (C1, C2) для контактных площадок и проводников, а слои маркировки (S1, 

S2) для контуров компонентов. Контуры легко создать с помощью обычных элементов 

топологии (окружностей, проводников и т.д)  

При создании макроса убедитесь, что ваш компонент расположен на стороне 1 платы.  

Это значит, что в создании макроса должны участвовать следующие слои: слоем 

шелкографии должен быть S1 (компоненты лежат на стороне 1 платы). Тогда проводящим 

слоем должен быть C1 для SMD-компонентов (поверхностно-монтируемых) или C2 для 

выводных компонентов.  

Сохранить свой макрос можно, выбрав в главном меню File > Save as macro, или нажав 

соответствующую кнопку в библиотеке макросов. В появившемся диалоге нужно указать 

имя макроса и папку, в которую он будет сохранен. Расширение файла макроса *.LMK 

добавляется автоматически. В качестве макроса можно сохранить всю топологию или ее 

часть. Если в текущем слое выделены какие-либо элементы, то в файл макроса 

сохраняются именно они. Если ничего конкретно не выделено, вся топология сохраняется 

как макрос (после подтверждения).  

5.4. Удаление макросов 

Выделите макрос в библиотеке и нажмите соответствующую кнопку удаления в 

библиотеке макросов. После вашего подтверждения файл выделенного макроса будет 

удален.  

Можно также использовать проводник Windows для удаления и упорядочивания файлов 

макросов (они имеют расширение *.LMK).  
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6. Печать и экспорт 

6.1. Печать 

С помощью этой функции можно распечатать свою топологию на бумаге или пленке.На 

пленку (фотошаблон) топология обычно выводится после некоторой дополнительной 

обработки в специализированных приложениях производителями печатных плат. И 

делается это на специальных плоттерах. Если вам нужна качественная плата, выводить 

фотошаблоны самостоятельно на обычных лазерных (и тем более струйных) принтерах 

крайне не рекомендуется, поскольку они не обеспечивают требуемой постоянной 

оптической плотности краски (а уж если вам картридж какие-то народные умельцы 10 раз 

перезаправляли, то и говорить не о чем! ), в результате чего медь на плате может 

вытравливаться с тех участков, на которых должна оставаться.  

Выберите в главном меню File > Print или нажмите соответствующую кнопку на верхней 

панели инструментов .  

Появится окно предварительного просмотра того, что будет выведено на печать, а также 

диалог с опциями настройки. Изменении опций немедленно отражается на 

предпросмотре.  

 

Бумага отображается как белый лист. Красная пунктирная рамка ограничивает область 

печати на бумаге. Размер этой области зависит от вашего принтера и его драйвера. 
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Настроить расположение вашего рисунка на листе можно захватив рисунок левой кнопкой 

мыши и передвинув его в нужную позицию.  

Опции в левой части окна 

Layer - Слой. Выберите слои, которые будут выведены на печать. Вы можете выбрать 

свой цвет для каждого слоя. Для этого нажмите по цветному квадратику справа.  

Special layer - Особенности слоев. Здесь можно настроить опции сверления («сверловки», 

как выражаются производители) и паяльной маски.  

Soldermsk 1/2 - Маска для стороны 1/2. Создать паяльную маску на основе контактных 

площадок. Контактные площадки печатаются с размерами, увеличенными на 

определенное значение. Отверстия в площадках закрашены. Нажав кнопку Options - 

Установки, можно настроить свойства паяльной маски.  

Drillings 1/2 - «Сверловки» для стороны 1/2. Эта опция выводит на печать в виде текста 

диаметры рядом с каждым отверстием. Нажав кнопку Options - Установки, можно задать 

высоту текста.  

Mirror - Зеркально. Отразить рисунок относительно вертикальной оси.  

Targets - Кресты, Board outline - Рамка. Добавляет перекрестия по углам рисунка или 

рамку, ограничивающую его.  

Scanned copy - Задний план. Выводит на печать вместе с рисунком задний BMP фон.  

Invert - Негатив. Все, что было на листе черным, становится белым и наоборот.  

Scaling - Масштаб. Изменяет масштаб выводимого изображения от 10% до 1000%. === 

Опции в верхней части окна ===  

Centre - Центрирование рисунка по середине листа.  

Clipboard - Буфер.Копировать текущий предпросмотр в формате BMP в буфер обмена. 

Этот рисунок можно будет вставить в другом приложении.  

Tile - Размножить рисунок по вертикали и горизонтали. Можно настроить количество 

рисунков по Х и У и зазор между ними.  

Calibrate - Поправка. Некоторые принтеры искажают размеры выводимых рисунков. 

Чтобы предотвратить такое безобразие можно задать здесь поправочные коэффициенты 

по вертикали и горизонтали. Например, если линию длиной 200 мм принтер песатает 

длиной 201 мм, задайте поправочный коэф-т 200/201=0,995 и принтер напечатает все как 

надо.  

Setup - Выбор и насторойка принтера. Теущий принтер отображается в заголовке окна 

печати.  

Print - Немедленно напечатать все так, как видно в данный момент на предпросмотре.  

Cancel - Отменить печать и вернуться в редактор.  



6.2. Экспорт в формат BMP 

Чтобы создать BMP рисунок из слоев, которые в данный момент включены в редакторе, 

выберите File > Export > Bitmaps (*.bmp) в главном меню.  

 

Можно сделать рисунок ч/б (B&W) или цветным (Coloured) и настроить разрешение 

(Resolution). Обратите внимание на размер файла (Memory), который изменяется в 

зависимости от этих параметров. Нажав ОК задайте имя файла и папку в которую он 

будет сохранен.  

6.3. Экспорт в формат GIF 

Чтобы создать GIF рисунок из слоев, которые в данный момент включены в редакторе, 

выберите File > Export > Gif (*.gif) в главном меню.  

 

Можно настроить разрешение (Resolution). Нажав ОК задайте имя файла и папку в 

которую он будет сохранен.  

6.4. Экспорт в формат EMF 

Чтобы создать метафайл EMF из слоев, которые в данный момент включены в редакторе, 

выберите File > Export > Emf (*.emf) в главном меню. Задайте имя файла и папку в 

которую он будет сохранен.  

6.5. Экспорт в формат Gerber 
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Вы можете сохранять файлы в формате Gerber RS274-X, который является стандартом для 

обмена данными о топологии (такой файл примет любой производитель печатных плат). 

Расширение этих файлов (*.gbr). Вы должны создать Gerber-файл для каждого слоя 

(проводников, маркировки, паяльной маски) каждой стороны платы, чтобы полностью 

описать свою печатную плату (т.е. для каждого слоя отдельный файл). Для экспорта 

топологии в формат Gerber выберите File > Export > Gerber export в главном меню. 

Появится диалог:  

 

Прежде всего выберите слой для экспорта. Когда вы выбираете слой, опции Mirror и Board 

outline для этого слоя автоматически настраиваются по умолчанию, но вы можете их 

изменить, если необходимо.  

Mirror - Зеркально отразить экспортируемый слой. Обычно должны быть отражены слои 

со стороны 2.  

Board outline - Добавить прямоугольную рамку, ограничивающую плату.  

Punch drill holes - Разметка отверстий под «сверловку». Использовать эту опцию при 

экспорте в формат Gerber крайне не желательно. «Сверловка» обычно экспортируется в 

формат EXCELLON.  

Mark drill holes - Отметить отверстия. Добавляет в центр контактной площадки очень 

маленькую отметку. Опция доступна только при включенной предыдущей (крайне 

полезна, если вы собираетесь сверлить отверстия в своей плате ручной дрелью или 

коловоротом ).  

Options for solder mask - Опции для паяльной маски. Доступны только если выбран 

экспорт паяльной маски для слоя C1 или C2 (Solder mask C1/C2). Паяльная маска 

создается на основе контактных площадок и представляет собой сплошное 
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(непроводящее) покрытие с окошками точно над контактными площадками. Такое окошко 

по форме соответствуют контактной площадке, а по размерам должно быть больше этой 

контактной площадки на некоторую величину. Эту величину можно настроить отдельно 

для контактных площадок выводного монтажа (Pads) и для контактных площадок 

поверхностного монтажа (SMD-Pads). Отметьте галочками на основе площадок какого 

типа будет создаваться паяльная маска (можно отметить оба типа).  

Inverting output - Негатив. Все, что было в редакторе черным, становится белым и 

наоборот.  

Create export file - Сохранить Gerber-файл с выбранными опциями на диск.  

Внимание! Проконсультируйтесь сначала со своим производителем печатных плат по 

поводу того, какая информация и в каком формате понадобится ему для производства 

вашей платы.  

6.6. Экспорт в формат Excellon 

Файлы формата Excellon являются стандартом для обмена данными о «сверловке». Они 

имеют расширение (*.drl). Такой файл содержит информацию обо всех отверстиях на 

плате (координаты и диаметры). Обычно для одной платы создается один Excellon-файл. 

Чтобы экспортировать информацию об отверстиях в формат Excellon выберите File > 

Export > Drill data (Excellon) в главном меню.  

 

Origin of coordinates - Начало координат. Выберите сторону платы на основе которой 

будут созданы координаты отверстий. Если вы выберите сторону 2 (Drill from side 2) 

координаты будут горизонтально отражены. Начало координат всегда находится в левом 

нижнем углу.  

Unit of measurement - Единицы измерения. Миллиметры (mm) или дюймы (Inch). Обычно 

нужно выбирать мм но некоторые сверильные машины работают с дюймами.  

Floating point (xx.yy) - Плавающая точка. Количество знаков (до запятой,после запятой). 

Здесь можно выбрать нужный формат представления числовых данных. Обычно 
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используется формат 3.2. Если в качестве единиц выбраны дюймы, лучше установить 

формат 3.3, т.к. он обеспечит большую точность.  

Delete leading zeros - Удалить нули спереди (например, было 001.23, станет 1.23). Обычно 

пункт отмечен и его использование не вызывает каких-либо проблем.Однако если они 

возникают, снимите галочку с этого пункта.  

7. Разные функции 

7.1. Информация о проекте 

Используйте эту опцию, чтобы добавить в свой проект информацию об авторских правах 

и комментарии. Вы можете открыть окно информации о проекте, нажав соответствующую 

кнопку на верхней панели инструментов .  

 

Title - Название.  

Author - Автор.  

Company - Организация.  

Comment - Описание.  

(Бесспорно, весьма важная функция. Без нее проектирование печатной платы потеряло бы 

всякий смысл! )  

7.2. Переустановка цвета 
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Вы можете сами настроить цвета для всех 4-х слоев (Copper 1/2, Silkscreen 1/2), фона 

(Background), сетки (Grid) и перемычек (Connections). Чтобы настроить эти цвета 

выберите в главном меню Options > Define colors.  

 

Вы можете выбрать из списка одну из четырех цветовых схем:  

 Default - Стандартная схема. Изменить ее нельзя. 

 User 1…3 - Настройка 1…3. Пользовательские настройки. Чтобы настроить цвета, 

просто щелкните по соответствующему квадратику и выберите новый цвет. 

7.3. Текущие папки 

Вы можете задать папки, в которые будут сохраняться и из которых будут открываться 

файлы соответствующих типов. Чтобы сделать это выберите в главном меню File > 

Directories.  

 

В появившемся диалоге выберите удобные для вас папки.  

Layout files - Файлы плат Sprint-Layout (*.lay).  

Gerber export - Экспортируемые файлы в формате Gerber (*.gbr).  
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Graphic export - Экспортируемые файлы рисунков (*.bmp; *.gif; *.emf).  

Scanned copy - Файлы фоновых изображений (*.bmp).  

Нажав кнопку »…» можно указать путь к существующей папке в проводнике, а можно 

просто ввести адрес папки в текстовом поле. Всякий раз, когда вы запускаете SL, эти 

папки используются в качестве папок по умолчанию для сохранения и открытия файлов.  

© Князев Александр Источник: Sprint-Layout. Руководство пользователя.  

Только авторизованные участники могут оставлять комментарии.  
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